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Kintraks Help 
Version 10.04 onwards 

 
Please Note: This Help file should be used as a comprehensive guide and reference to all the features when you 
are ready to explore them in more detail. Use the Quickstart guide to get you started with basic features and to 
familiarise yourself with the program interface. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 

 
 
 
 
 
 
 
 
Website: http://www.kintraks.com 
Author: Craig Grech 
Email: support@kintraks.com 

 

 
Disclaimer: This software product is provided by Kintraks Animal Software "as is" and "with all faults." The provider makes no 
representations or warranties of any kind concerning the safety, suitability, lack of viruses, inaccuracies, typographical errors, or 
other harmful components of this software product. There are inherent dangers in the use of any software, and you are solely 
responsible for determining whether this software product is compatible with your equipment and other software installed on 
your equipment. You are also solely responsible for the protection of your equipment and backup of your data, and Kintraks 
Animal Software will not be liable for any damages you may suffer in connection with using, modifying, or distributing this 
software product.
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About Kintraks 
 

 
 
Kintraks Animal Breeder is a computer program designed to centralise all you animal record keeping in one 
location. By grouping animal details and characteristics into separate records Kintraks can run functions to produce 
pedigrees, reports and documents. 
 Kintraks stores all information in databases. These files can be identified by the Kintraks document icon or the 
.cax file extension. 
 

 
 
Animal Breeder is different from most mainstream animal registers because it allows you to create as many 
different databases as you please. If you breed Cats, Dogs and Rabbits then each can have a completely separate 
database with different settings for each, right down to pedigree layout and graphics. 
 
Another advantage is that all versions of the program - Windows, Mac and Linux, use the same database format. 
This means you can open your database and work on it on most computers and operating systems.  
You can even copy all three versions of Kintraks to a USB flash drive alongside your databases. Plug it into your 
PC at work to update your records, then take it home and plug it into your Mac to continue working on the same 
files.  
 
The first step is to create a database for a species. You will be prompted to name your new database. You need to 
enter a few specific details about the animal species so it can be used in terminology and calculations. If you are 
stuck then Kintraks will provide a default setup to get you started. 
 
When done you can begin adding individual records. Each record can be linked with another through the Mother 
and Father fields. The program doesn’t store a pedigree as often thought, it creates it instantly when you ask for it. 
This means that all names, relationships and titles in your pedigree are always up to date in all parts of the program 
after any changes are made. 
As you build your database you will be able to see pedigree relationships forming. This can be quite enjoyable. 
 
An alternate way of building your database is to import it from existing records. You may have an Excel file of your 
animal records or have exported a csv or text file from another program. You can also import selected records from 
another breeder. 
 
Before you start building your first database a word about data backup. I often receive emails for help from 
distressed customers stating that their computer has malfunctioned or been stolen, and they’ve lost years of animal 
data. Do not even think about using a computer to store your data unless you intend to make reliable backup 
copies to protect it. Please read the section on backing up your databases as soon as you can. 
 

 
Ok, so let’s get started … 
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Installing 
 

 
 
Kintraks is available in three different versions to suit desktop operating systems - Windows, Mac and Linux. All 
versions have the same features and work the same way. 
As a registered Kintraks customer you can download the program from the Internet and install it on your computer 
at any time. If you have purchased on CD and the disk is lost or damaged don’t worry, just download the program 
and request a copy of your key. The most important part is the database files you have created and not the 
program. Remember to backup and you won't have to worry. 
The install procedure varies depending on the operating system and whether you are running the program from 
your computer hard drive or as a portable application from a removable drive. 
 
Go to the Kintraks website www.kintraks.com and visit the Downloads page. Find the section for your computer 
operating system and click on the Download link. There is only one installer file for Trial and Full versions. The 
program is restricted to 200 animal records (trial version) until unlocked by a Kintraks registration key when it 
becomes the full version. (see registering) 
 
 

 
Windows 
 
When you click on the download link you will be prompted to RUN or SAVE the file. (some browsers you may only 
be given the option to SAVE). 
You will be asked for a location to save the installer file or your browser may automatically save it in your 
Downloads folder. After the download completes you will need to locate the file in this folder and run it. 
Double click to install Animal Breeder.  
 
Screen – Windows 10 (Microsoft Edge Browser) 
 
You may OPEN the file directly from the Internet. Windows will give you a standard warning about 
running files from the Internet. Click the More Info link then select Run Anyway. You must agree to all security 
prompts to begin the installation. 
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Mac 
 
The Mac version comes as a Mac pkg file. This will 
install the program in your Applications folder. If you 
already have the program somewhere else on your 
Mac delete or rename it before upgrading to prevent 
the wrong copy from being upgraded. 

 
 
Once installed open your Applications folder and drag 
the Animal Breeder App to your Dock to create a 
shortcut. 
 

 

 

 

Linux 
The program is contained in a zipped archive. Make sure you install the correct version for your operating system. 
I recommend 64 bit Linux Mint but it will work with other distributions. 
Download to your computer and double click to extract the contents to your Home directory or folder of your 
choice.  
Wherever you choose to run the program from, the Kintraks executable must be in the same directory as the 
Kintraks.Lib and Resources folder for the program to work. Depending on the Linux distribution the program my 
not run without a little modification.  
Right click the Animal Breeder file and choose Properties.  
 

 
 
Click the Permissions tab and check Is Executable (or similar). Save the changes.  
Your program should be ready to run now. 
The Linux version is free and unrestricted. No registration is required but I do appreciate feedback and  
bug reports. 
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Portable 
All three versions of Kintraks (Windows, Mac and Linux) can be run as portable applications from a  
removable drive eg. USB flash drive.  
A portable application does not need to be installed on the computer hard drive to run. 
By storing your databases, backgrounds and pictures on the USB drive you can take Kintraks with you and  
use it immediately on another computer. All versions of Kintraks share the same database format so you  
can use any version to access and update your database depending on what operating system the  
computer runs.  
 
A separate download is available for Windows. To run the Mac as a portable application simply use the 
regular download. Copy the app to your USB drive. For Linux, extract the zipped archive directly to your 
USB drive.  
 
To run insert the USB drive into your computer. On Mac and Linux distributions you should see your USB 
drive on your desktop. Open it to view the contents. Run the Kintraks file for your operating system  
eg. “Animal Breeder”. It will probably be the one with the Kintraks icon. 
 
Your operating system should recognise that you are running the program on a separate drive to the  
operating system and prompt you with a message: 
 

 
 
If you click Yes the program will run in portable mode. 
If you click No the program will behave as though it has been installed on your computer. All files will be  
stored as per normal in your Kintraks folder in your Documents. 
 

Tip: You will not be prompted next time you run the program from this drive because the program has saved your 
 choice in a small file on your USB disk called noprompt. To reset your choice delete this file from your USB drive and  
restart the program. 
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Registering 
 

 
Kintraks requires registration to unlock all features and remove the 200 record limit. Purchasing a registration key 
will enable you to update to future versions of the program free of charge, have a say in new features and receive 
Email support with you need help.  
 
Your registration key must be copied to the folder where your databases are kept. If you are running the program 
from your main hard drive this will normally be the Kintraks folder in your Documents. On a removable drive your 
registration key needs to be in the same folder as the program. You can immediately remove the restrictions on 
any trial version by copying the registration key to the database location. 
If you don’t see your registration name in the start-up screen it means that there is no registration key file present. 
You may also be reminded when you attempt to enter more than 200 records. 
 

 

Kintraks will automatically unlock on older operating systems and does not 
require a registration key: 
 
• Windows 7, 8.1 and 10 
• Mac High Sierra, Mojave, Catalina, Big Sur 
• All Versions for Linux 
 

 
 
If you lose your registration key simply email support@kintraks.com and request a copy (free of charge). Include 
your full name and your Paypal email address that will identify you as a purchaser. 
 
The program will check your existing key when you install or upgrade to a new version and will retain your 
registration unless there has been a violation of terms and conditions for example: 
 
• You cancelled your payment or requested a refund after registering. 
• You are using someone else’s key which has been uploaded on a pirate or a file sharing site. 
• You deliberately shared your key with other people through Email, Facebook or other website. 
 
If you are the genuine owner of a key which has been pirated or stolen through no fault of your own, please contact 
Kintraks support for help.  
 

Tip: Don’t assume your key is blacklisted if it suddenly stops working. Keys can corrupt if tampered with or opened with 
other programs such as text editors. The result will be that the program displays strange characters as the registered name or 
“Unregistered Kintraks User”. You may just need to request a free replacement key. 
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Uninstalling and re-installing 
 

Uninstall 
Uninstalling or re-installing over the top of an existing installation will not affect your data. Because databases are 
something you have created yourself, they are not on the list of items to remove when you uninstall nor are they 
replaced when you re-install. Because they remain after you remove the program they will be available when you 
install the program again. 
 
To completely remove Kintraks for Windows go to Settings > Apps > Installed Apps (On the list of programs right 
click on Kintraks. Choose Uninstall.  
To completely remove all traces of Kintraks  open your Documents folder and delete the Kintraks folder (all 
operating systems). This will remove your databases, registration and pictures as well.  
Make sure this is what you want to do? 
 
To remove Kintraks from a Mac or Linux computer simply drag all installed files, folders to your Trash/Recycle bin. 
Remove links and shortcuts. 

Reinstall 
Reinstalling can upgrade an old version of the program or replace corrupt or missing files on a current version.  
It is an easy solution to fix most runtime errors. Whether you are running a free trial or registered version simply go 
to the Kintraks website and download the latest trial version of the program for your operating system.  
 
The trial version is just the full version without a registration key. The program will check your existing key when 
you install and retain your registration. 
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Starting up 
 

 

Windows 
During Windows setup there was the option to create a Desktop shortcut. You may start the program by double-
clicking on it. Another way is to open the program through the START menu. Go to All Programs > Kintraks and 
click on the Kintraks icon. 
 
If the program fails to start there could be several reasons: 
 

1. Kintraks is already running or has crashed and components are still running in the background. 
Hold down Ctrl+Alt+Del >> Task List >> Applications. Click on Kintraks if it’s on the list then End Task. 
Try to restart the program. 

2. Your shortcut is not pointing at the program. Try starting from the start menu. Delete all desktop shortcuts 
and re-install (see Uninstall and reinstall).  

 

Mac 
If you dragged the Kintraks icon to the dock you now have a convenient way to launch the program. If the program 
disappears from the screen at any time click on the icon to bring it back to focus. 
 

Linux 
Depending on the Linux distro there is usually a way to create a desktop shortcut or link. Try right clicking on the 
Kintraks icon for choices or consult your Operating System documentation. 
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The Splash Screen 
 
The first screen that appears is called the Splash screen. This screen appears for a few seconds while the program 
prepares to run. Your registration information and the version number appear at the bottom of the screen. 
 
Do not click on this screen as it will close the program. (This is a way 
to exit if the program ever freezes while starting).  
 
If you have saved some pictures with your animal records the 
program displays a random picture choice with the Kintraks logo each 
time you open. If you haven’t saved any pictures it displays the 
default picture. 
 

 
 

The Main program Window 
As soon as the splash screen closes you will be 
presented with the main program window. From this 
window you can create a new database or open an 
existing one. 
 
At the top of the window are menu items which give 
you access to all the Kintraks functions. Underneath 
that is a toolbar consisting of buttons for the most 
commonly used functions. 
 

 
 
 
 
Screens – Mac Ventura 
 

 
 

If an item isn’t in the toolbar check the main 
menu. 
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You should use the program at full screen where possible to display maximum information. You can do this by 
clicking the program Maximize button or dragging the edges of the window to enlarge it. 
If you cannot see the whole program on startup and therefore cannot access anything, resize options click Window 
> Reset Size from the menu or use your keyboard Ctrl+T (Mac use Cmd + T) .  
 

 
 
Kintraks may not display correctly at display settings less than 1024x768. Check you operating system display 
settings if you cannot see the program fully when you open it. 
 
 

Creating a database 

 

 
 
Important: If you are upgrading from the original Kintraks version for Windows (Versions 3.** to 6.**) see the 
section Importing an old version Kintraks (cav) database for directions on how to copy the whole database to 
the new version format. 
By default the program will create a new database in a subfolder of your user Documents folder called Kintraks. 
 
 
Now you can create a new database in the chosen 
location. 
 
 
From the main window click the New button. 
Give your database a simple name when prompted. 
Usually just the species of animal is normally enough. 
After creating a database the filename will appear in 
the Main Window. You can open the database by 
clicking on the name. 
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Enter Setting 

After creating a new database, the program will prompt 
you to enter settings for the database. Click the 
Settings button on the top toolbar. 
 

 
 
 

                                                                  
    
          

 
 
 
The settings form consists of 6 tabs. The minimum information required to make the program run is just a few 
boxes with red labels. The program will help you with this part. As you move your mouse over each box or click on 
the drop down lists some information will display on the right side of the form in green to help you fill it in. 
 

 

 
 
 
A handy helper on the Animals Tab is the 
Autofill button.  
 
It will enter default information for any of 
the animals listed in the Animal Type list. 
 
 If you disagree with any of the details 
entered just edit them. If you don’t like the 
results at all click the Clear button and do 
it manually. 
 
If you keep an animal that isn’t on the list 
you will need to type in the animal species 
name in the box and enter the other 
details from your own knowledge.  
 
 

When you use the Autofill button it also fills in the tab – Custom Fields. 
This page allows you to make fields to keep information on aspects of your animal which don’t appear on the 
Animal tab. 
This list may not be exactly what you want so feel free to edit and customise it. 
 

Tip: You can leave some boxes blank for later if you like. After using the program a while you often think of some other 
field you wish you had. 
 
Click SAVE to save your database setup. These details will be used in this database only. You can use the same 
process to create more databases for completely different animals. 
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Add Records 
 

 
Having saved our Settings for the database we can now start adding records.  
 
Gather all your paperwork together. If you are working from a pedigree certificate start with the Subject animal and 
work from the top of the page to the bottom so you can remember what you’ve completed. 
 
Click the New [animal] button on the main window 
toolbar.  
  

 
The Add/Edit form opens. As with the Settings form the minimum requirement to create a record is the fields with 
red labels – Name and Sex. 
 
Screens – Windows 11 
 

 
 
Next is a little about each section: 
 

Details 
You only need two pieces of information to create a record – Name and Sex. This takes no more time than it would 
to enter your pedigree in a spreadsheet or word document but having a separate record for each animal means 
you never have to type that name again in any pedigree or report. 

Name 
Compulsory field. Enter the animals full name (without titles) eg. Nicholas Martinis 
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Sex 
Compulsory field. Click the drop-down list to see the names you entered in your Setting for Male and Female of 
the breed. You cannot type anything in this box, you must choose one.  
 
You may choose undefined if for example the animal or bird was a juvenile and had not been sexed. 
Undefined animals cannot be used in most of the mating functions throughout the program but it allows you to 
make a record which can be edited and finished later on. 
 

  
 
Other fields are optional but the more information you enter the more you will get out of using the program. 
 

Prefix 
Enter the animal’s prefix title eg. Ch, GrCh (Rabbits) or any common prefix. Cavy breeders often put their stud in 
front of the animal name eg. “Flower Power”.  

Suffix 
Any title that follows the name eg. HX or MX. Some breeders put also country initials eg. (UK).  
The program will add the prefix and suffix when it displays the name. 
 

GrCh Forget Me Not (UK) 
 

Names with anything in the prefix box will automatically be displayed in red on the pedigree. Many breeders 
highlight champions this way. You can turn this feature off when creating your pedigree or choose a different colour 
in the pedigree settings. We will look at this later. 

Call Name 
The animal’s short name or call name eg. Nick 
 

Microchip 
If the animal has a microchip you can enter the number here 
 

Tag / Reg 
Tag or Registration number. The contents may vary depending on the animal. It could be a brand, tattoo, 
band(bird), or just an official registration or microchip number.  
If there are several identification numbers, you might consider making a field for it in the Custom Fields tab of your 
Settings.  
You can also use the Record Number or Random buttons to generate a unique record number. You cannot have 
two animals with the same registration number. 

Cage # 
Enter the cage, paddock or pen number that this animal is currently kept in. Some animals can only be identified by 
the cage number  
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Breed 
This list is empty the first time you use the program. 
To simplify the program and allow you to just deal with the breeds you are associated with you just type in a new 
breed each time you need it. 
 
The next time you add an animal the previously entered breed names will be the drop down list choices. Always 
check the list first before adding a new breed. Some breeder may have many breeds in this list, others will have 
only one. 
 
 

 
 

Colour 
The Colour (USA – color) list works the same as the Breed list. As you enter new colours the list grows giving you 
more choices. 
 

 
 

Using Breed and Color lists 

 
Another method of filling Breed and Color lists is to use pre-set list. Once you select this option in Settings, the list 
will no longer automatically fill with entries you have used before. It will only display what is on the lists. 
 

 
 

Birth Date 
If you know the birthdate (DOB) enter it here.  You can use the date picker beside the DOB box but for dates years 
back it is often easier to just type it in. Use the short date format for your region. Hold your mouse over the box to 
see this format in the popup tool tip. This applies to all dates entered in the program. 
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If you don’t know the birthday take a guess by using the estimate button to reveal some input boxes for years, 
months and days. 
The program will calculate an approximate birthdate. This is far better than leaving it blank as many functions within 
the program depend on a date of birth. The DOB will be appended with the word (Estimated) whenever it appears 
in the program. 
 

 

Father / Mother 
These boxes may not be labelled father and mother if you have chosen a different title for your animals in Settings 
eg. They could be Sire and Dam.  
 
When you click on the Find button next to the Father or Mother entries a name finder will open. 
 
The list will contain valid choices as determined by sex and lifespan. If the animal you are looking for is not on the 
list then something is wrong with the subject animal or the partners sex and date of birth.  
Use the search options to find the parent you are looking for and click on the name to close the form and put it in 
the parent box. 
 
 
You can also sort columns in the Name chooser by clicking the column header eg. To find the last animal entered 
click the Date Added column until the most recent entry is at the top of the list 

You can clear the Parent box on the Edit form anytime with the clear  button. 
Don’t despair if you haven’t created parents yet. Click the New button to open a new form where you can add the 
parent details. When you save, the form will close and the parent name will appear on the original form. 
 

  



[Type here] 
 

Status 
This section is used by the program to group animals together. It filters search results to manageable lists of just 
the animals in your possession.  

You can check more than one choice. 

 

I am the breeder 
You bred this animal yourself. This option is not 
connected with any other choice but helps with 
searching and pedigree label. 

I am the owner 
If you are the owner of animal and it is not sold, 
leased or deceased, the program will presume 
you have the animal in your cage or yard. 

For Sale  

Checking this box will list the animal for sale in 
your finance records. 

Sold 
Check this if the animal is sold and a box will 
appear for the Sold Date. When you fill in a date 
the program will calculate at what age it was sold. 

Leased 
If you are borrowing or leasing an animal from 
another breeder then check this box. 

Deceased 
Check this if the animal is dead and a box will 
appear for the Deceased Date and reason for 
death. When you fill it in the program will know 
how long the animal lived. The reason may be 
any of the choices on the list or you may enter 
your own reason. 

Purchased 
If you want to enter a purchase date and price use 
this option 

 

Groups 
Groups are an easy way to collect similar animals together. The animals can have similar characteristics that set 
them apart. Anything from a particular litter, favourite show animals or animals that may carry a certain disease or 
trait. 
A group can be displayed easily in the Search list by selecting the group name from the Search list or drop down 
lists on other forms. This makes it easy to apply bulk edits or select all the animals in the group for treatments. 
 
An animal can belong to many groups. To create a group simply select one or more animals in the Search list and 
right-click, then choose Create Group. 
You can also edit an animal and use the Group options on the Status page.  
 
Note – when you use the NEW button the group name will not appear in any drop-down list until you save the 
animal. 
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Group names will appear with a # in the general record information. 
 

  
 
 

Custom Fields 
Do you remember the 15 extra fields on the third tab of Settings? 
Well here they are. The same process works here as for the Breed and Colour fields. Check the drop-down list of 
previous entries. If it isn’t on the list then type it in to add it to the list next time. 
Now that you have finished entering your new record click the SAVE button. You will be prompted to enter more 
records with the same details. 
 

Notes / Awards 
Enter any notes or awards here. This text can be displayed on printouts and pedigrees so best to keep it short and 
relevant. 
 

Heat Cycle 
This tab records special heat cycle intervals that may be different than the default for the database. If all the 
animals in the database have the same heat cycle interval, then this tab can be left blank. See the separate section 
on Heat Cycle for details of this option. 
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Search 

 
Now we have added some animals, where are they? 
Have a look at the Search pane on the left side of the main program window. New records should appear in the 
Recent or All Records lists.  
To display the recent animals you have created or editted check the Recent 
checkbox. 
To view all records click in the Search box. Type any part of a name to filter the 
list. 
To display only your stock click the My [animal type] checkbox. Wherever the 
red heart checkbox appears in the program it can be selected to only display 
records where you are the owner and the animal is not sold or deceased. 

 

 

Using the  Filters Tab 
You can do a more refined search by opening the Filters tab. You will notice there are some other filters on the 
second list as well eg. Sold Stock.You can refine the search even further by using the third and fourth lists and the 
contains text option. 
 
Screens - Linux Mint 
 

 
 

 
Notice above how the red heart icon appears when you change the Status to something besides My Rabbits or All 
Records. This works the same by filtering results by My Stock (checked) or All Records (unchecked) giving you 
three search criteria. 

 
 
Searching by Date of Birth  
 



[Type here] 
 

 
Screens – Window 10 
 
 
To search for a list of animals born in a particular year. 
 
For example: to list all the animals born in 2018. 

 
 
 

 
 
 
 
 
To search for all animals born in a particular month. 
 
Use the universal date format in your search  
ie. yyyy-mm-dd as that is the format of the stored 
dates. 
 
For example: to list all the animals born in May 2019. 
 

 
 

  



[Type here] 
 

Opening Records 
 

 
 

View Profile Details 
 
Select a record from the Search list by clicking on it once.  
When you do this all the tabs on the main window will update with information relating to the selected animal. The 
first tab called Profile shows the information we entered when we created the record. It also adds the current Age 
as calculated from the Date of Birth. 
 

  
 

Edit details 
Any fields you leave blank do not appear. To edit these details double- click the name in the Search list. The 
Add/Edit form appears. Make changes then click Update. 
 

Tabs 
There are four toolbar buttons that refer to the individual animal selected in the Search list – Animal, Health, 
Breeding and Finance. Clicking on a button will display a section of r elated tabs below. 
 

 
 
When you choose a button the tabs at the top and buttons at the bottom change to suit. the menu buttons change 
to suit. 
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Animal 
 
First tab [may appear as the Animal species name eg. Cat] 
A summary of animal details including a selection of pictures. An area where you can add some notes of your own. 
Journal 
Record daily aspects of your animal. Each record is filed by date. 
Tree 
Displays the pedigree to 5 generations. Browse further up the family tree by clicking on names. Lists animals with the same 
pedigree.  
Descendants 
Offspring and descendants listed for 10 generations. 
Shows 
View show entries and results, awards for the selected animal or all animals. 
Documents 
Stores documents and scans in the Kintraks folder and allows you to select and view them from within the program. 

 
Health 
Treatments and Reminders 
Schedule health and other regular treatments. Details appear in the table and on the Calendar. 
Diet 
Record a feeding schedule for each day of the week and at particular times 
Weight 
Record your animal’s regular weight results and chart against the other animals in your database for comparison. 
[Health] Notes 
Any notes you want to keep relating to your animals health. 

Breeding 
Heat Cycle 
Displays the four stages of the heat cycle with their start date. Current phases are highlighted in color. 
Matings 
Displays mating records showing stages and results. 
Pairs 
List offspring grouped by parents and date of birth. An easy way to track progress of each litter. 

Finance 
Purchases 
Shows indiviual purchase details including date, price and seller. 
For Sale 
View records where the animal has the Status - For Sale. 
Sales 
View sale details of the individual or all records including buyers details. 
Produce 
If your animal produces a saleable product for example,. milk, wool etc. you can track and graph it here. 
Expenditure 
A simple way to calculate income and expenses and view totals under Individual or All animals. Sort by financial years. 
Waiting 
Keep track of customers waiting to purchase animals.  
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Add pictures 

 

 
 

Add a picture 
 
There are several ways to add pictures to a record. Before you add any pictures you should choose the method the 
program will use to store the picture. Pictures can be stored inside the database or as separate files which the 
program will find and display with the appropriate record. 
The advantage of storing the pictures in the database is portability. You only need to backup the database file to 
keep everything together. You can send it to another breeder and when they open it they will see the pictures as 
well. The disadvantage is that the pictures are going to increase the database size considerably. The alternative is 
to store the pictures as separate files. The program will create a pictures folder and label the picture with the animal 
name and picture caption. You must remember to ensure the pictures are backed up with the database or they will 
be lost. 
 
Open your Settings and go to the Options tab. Under Pictures check the option Store pictures in database. 
Below the checkbox is a slider which allows you to set the picture quality. The minimum setting will store the picture 
with dimensions of 800 x 600 pixels. It is recommended that you choose the minimum setting. 
 
This process doesn’t affect your original picture, but you should note that if you lose the original picture then the 
database version may be of a lesser quality. 
 
Now we are ready to add pictures to a record. Select a name from the Search list. Make sure the first tab is 
selected. The first picture box labelled Pedigree will be used in the animal’s pedigree.  
 
Note in the images below that there is a different icon in the box depending on whether you are storing the picture 
in your database or saving it as a separate file. 
 
Screens – Windows XP 
                                
 
Click the box to select a picture. You may then choose a picture or drag image file to the boxes. 
 

 
 

Delete a picture 
To delete a picture select the picture so it is displayed 
then right-click and select the Delete Photo menu 
choice. 
If you delete them then they cannot be recovered. 
Make sure you still have the originals before doing this. 

 

 
 
 
 
 

Swap a picture  
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To swap pictures, for example you want a different picture as the pedigree picture, click the Swap button  at 
the top to display the Swap Pictures window. Choose the two pictures from the list then click the Swap button. 
 

 
 
Altogether you can store nine pictures for each storage option.  
If you change the storage option eg. from picture files to database stored, the other pictures will remain and can be 
viewed by changing the option back. 
You can do this quickly without changing your settings by using the Change Location 
button.  
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Health records 
 

 

Treatments and reminders 
A big part of managing your animal’s health is the scheduling and recording of treatments. These could be 
vaccinations or perhaps regular grooming such as nail clipping. 
Some treatments need to be entered for all your animals in your care while others are scheduled according to 
individual animal needs. Kintraks caters for both. 
 
Screens – Windows 10 
 

 
 

Add Treatment 
 
To add a treatment select the animal from the Search list then click the Add button above in the Treatments 
section.  
 
The Add Treatment form opens.  
Enter the Due Date and Treatment or 
Reminder. 
 
Options 
You may add this reminder to all your current 
animal’s treatment records by filling in the 
bottom section as well. 
You must check the box to add to all records 
and fill in a schedule interval (days) and a 
duration (years). 
 
Click Save. You will be prompted to enter  
more treatments or close. The table should 
update immediately with the new entry. 
 

 
 

 

Edit Treatment 
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To Edit a record click on the entry in the table  

to open the Treatment form again. It will display Update and Delete buttons. Make changes then click Update 
when done. 

Delete Treatment 
 
Click on the entry in the table. When the treatment form opens click the Delete button. 
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Weights 
Kintraks stores weights for individual animals by date weighed and time and lists them in a table. The program 
creates a basic chart so you can view and compare weight gain or loss. 
 
Screen – Linux Mint 
 

 
 

Add 
To add a weight select the animal from the Search list then click the button in the weights section. 
 

   
 
The Add Weight form opens. The current date and 
time are filled in for you. If this is  
not the time of weighing you will need to edit them. 
 
The measurement of weight is the one you 
entered in the Settings eg. Kilograms. Enter the 
weight.  
You may use decimal places if you wish. 
 
Click Save when done. You will be prompted  
to enter more weights or close. The table and 
chart should update immediately on saving a new 
weight. 
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Edit 
 
To Edit a weight click on the entry on the table. 
The form will open so you can make changes. It 
will display Update and Delete buttons. Make 
changes then click Update when done. 
 

Delete 
 
Click on the entry in the table. When the weight  
form opens click the Delete button. 
 

 

Tip: In your Settings go to the Custom Fields tab and create a custom field called Weight.  
Whenever you save a new weight on the Health page this custom field will update with the latest weight. 
 

Notes 

 
The Health page contains a blank area for notes. Click on the text area or use the Add button in the Notes section 
to open the notes form. 
 

 
 
You can use this section for anything you like from medication to diet to grooming notes. 
Add or edit existing notes then click Save. 
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Pedigree 

 
The Pedigree tab displays a pedigree by looking up the information you have entered in individual records. Rather 
than store a pedigree which could be out of date when animals are born, renamed or added, the program simply 
looks up the parents of the subject animal then finds their parents, then their parents etc. etc. This is done in an 
instant creating the animal’s Family Tree. 
 
To view a Family Tree select a record from the search list then click on the Family Tree tab. 
 

 
 
The family tree is displayed back four generations, five if you maximise the screen. If the family tree has blanks it is 
normally because the animal hasn’t any parents entered.  
If you need to add parents right click on a name and choose Add father or Add Mother. Note the Show pop-ups 
checkbox must be unchecked for this function to operate. 
 

 

 
This is also an easy way to build a family tree. It will open an Add Record form and when you save the tree will 
refresh automatically with the new parents.  
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Shows 

 
The Shows page helps you keep track of show events, entries, awards and judges.  
 
Shows may by filtered by Name to display just entries for the animal name on the Search list or All Record filters 
Last 12 Months or Show Year. When you click Show Year a drop down menu will allow you to choose a year. 
 
 

Add 
When you click the Add Show button on the  
Shows page a form opens where you can add 
a new show record. It is not necessary to 
select an animal from the Search page first but 
you may. 
 
Select the animal’s name from the Name list at 
the top. If there are a lot of records in your 
database you may use the red Heart checkbox 
to fill the list with all records (unchecked) or 
just  
your stock (checked). 
 
 

Edit / Delete 
 
To Edit a Show record click on the entry in the 
Shows table to open the Add Show Result 
form again in edit mode. It will display Update 
and  
Delete buttons. 
Make changes then click Update when done.  
You may also delete the record using the 
Delete button. 
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Breeding 

Heat Cycle 

 

 
 
Heat cycles can be unpredictable, so the program allows you to adjust dates for the four phases of the cycle. 
Open Settings and enter the length of each phase. 
For example, for a dog the heat cycle may take 129 days comprising of –  

Proestrus: vaginal discharge, males attracted to females, females unwilling to mate. Length: 4-20 days. 
Estrus: swollen vulva, yellowish vaginal discharge, mating occurs during this phase. Length: 5-13 days. 
Metestrus: (or Diestrus): the period after Estrus or mating. Length: 60-90 days.  
Anestrus: the period of inactivity (sexual and hormonal) between Estrus phases. Length: 60 – 90 days. 

Open your settings and enter the length of each 
interval. This is not accurate but does provide a 
basis for tracking each stage. 

 
 

If your animals have different heat cycle intervals, 
you can over-ride these settings by editing the 
individual animal and entering unique intervals. 
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Let’s say you have done your research and 
determined that an animal is entering a new phase 
of the heat cycle.  
Select the animal record from the Search list and 
open the Heat Tab (Under the Breeding tab). 
Click the Add button. 

Enter the date that the particular stage of the cycle 
began. Click the Calendar icon to choose a date. 
The rest of the cycle will automatically adjust the 
intervals to suit giving you new predicted dates for 
the rest of the cycle. 
Click Save. 
The reminders for the next stage will now appear 
in the heat table. 

 

 

Matings 

 
The Matings and Pairs page work together to help you keep track of breeding records and schedules.  
 
Screens – Mac Monterey 

  
 
 
The Mating page defaults to the Parent option and lists matings which involve the animal selected in the Search 
list whether it is the father or mother. If no animal is selected in the Search it defaults to All Records for the Last 
12 Months.  
Other All Record options are Year Mated or Year Born. A drop down list will appear allowing you to select a date 
from the last 20 years. You can go back further if necessary by typing the year in the box. 
You can also view matings which involve the animal in the Search list and one other by clicking the Mate option. A 
list of animals of the opposite sex will appear for you to select from. 
 
This follows a simple process in order of the breeding steps: 
1. Start a mating record 
When you put two animals together to mate open the Mating page, no need to select anything from the search list. 
Click the Add Mating button to show the Add Mating form.  
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Select a Breed from the list ot type one.  
Select the animal names from the father and mother lists. These lists may be labelled differently, for example Sire 
and Dam depending what you entered in the Settings for Father and Mother.  

By default these lists show only your current stock but you can uncheck the red heart 
options  
to list all records sorted by males or females. 
 

 

Enter the Date mated then click Save. That’s all that’s necessary for now. 
 
2. Enter an Unsuccessful Mating 
If time passes and the mating is not successful (no pregnancy, eggs or whatever) you need to close this mating 
record. Open the Mating page and click the Last 12 Months option.  
This is the easiest way to find your recent mating records. Another way is to click on the name of one of the parents 
in the Search list and find the record on the Mating page (defaults to Parent option). 
 

Check the Not pregnant option and save. 
 

 
 
 
3. Monitor a Successful Mating 
If the animal is pregnant take note of the date in the mating record to prepare a bed or nestbox for the animal. 
Another function of the program the Calendar will list this date and projected day of the birth so you don’t need to 
keep looking at the Mating page for these dates. We will look at the Calendar later. 
 
 
4. Enter the Birth 
The happy day has arrived. Open the mating record and enter the birth date and the number of males, females and 
stillborn if any. 

 
 
 

5. Create Litter Records 
Click the Make Litter Records button. A dialog will appear asking you if the default name is OK to use, just to 
temporarily name them. The name is derived from the date of birth and parts of the parent’s names. You can enter 
your own choice if you like. 
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When you click OK the program will make records for the male and female animals born live. Offspring are 
numbered eg. Male(1) Male(2). These names will appear in your program Search list under your current stock. 
They can also be viewed on the Pairs tab.  
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Hatch 

 

 
If your animal lays eggs then you can substitute the Mating page for the Hatch page. To do this open your Settings 
and select the animals tab. 
Check the box “This animal lays eggs”. 
 

 
 
 
The Hatch page will replace the Matings page and organised to displayed your incubation and hatch information. 

 
 
 
When a batch of eggs are laid click the Add button to start a new clutch record.  
During the stages of incubation and hatching edit the record to add more information and notes. 
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Pairs 

 

 
 
The Pairs page isn’t particular interactive but is useful for grouping animals with their siblings and parents. 
 
When you click an animal name on the Search list the Pairs page displays all offspring by that animal. Like the 
Matings page it defaults to the Parent option but can be changed to display All Records with different filters. 
 
Screens – Mac Snow Leopard 
 

 
 
The Details column will show the age if it is alive, but can also show other details like date sold or deceased. Even 
when you give each animal a proper name they will still remain grouped with their parents on this page so you can 
view them together. 
 
All entries on this page can be filtered by I am the breeder even when the  
other options are selected. 

 
 
You can click on each animal on the litter page to open its record for editing. Since it is easy to accidentally click on 
this page and inadvertently open a record you will get a prompt first. 
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Finance 

 

 
Screens – Linux Mandriva 2010 
 
The Finance page keeps simple income and expense records for your database. By selecting a name from the 
Search list the Finance page will display financial information relating to the particular animal. 
 

 
 
When you click on any of the All Records options you can view income and expenditure for all records in your 
database. You can also filter by Last 12 months and Fiscal Year. This opens a drop down list of common financial 
year end dates.  
 

 
 
Add 
To add a record of an income or expense click the Add Expense button on the Finance page to show the Add 
Finance Record form. 
 

 
 
Select the option for Income or Expense then select a name from the list. By unchecking the red Heart box you 
can change the search list from your current stock to all records in the database. 
 
Add a short description in the Details box then enter the amount (only numeric characters). 
Click Save. 
 
Edit / Delete 
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To Edit a Financial record click on the entry in the Finances table to open the Finances form again in edit mode. 
Make your chages and click Update or choose the Delete button to remove the record. 
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Sales 

 

 
The recording of sale details in an import part of running any breeder operation. The Sales page shows the date 
and details of each sale entered and displays in a table allowing you to compare records. 
 
Screens – Windows XP 
 
 

 
 
 

Add 
 
To add a sale record click the Add Sale button on the Sales page. Unlike other functions you don’t need to select 
an animal from the main Search list.  
 
The Add Sale form opens. Select the animal’s name from the Name list at the top. If there are a lot of records in 
your database you may use the red Heart checkbox to fill the list with all records (unchecked) or just your stock 
(checked). Once you select the name the known details of this animal will populate some of the other boxes which 
are greyed out.  
Add a Date Sold. 
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Select a buyer if the name exists on the Buyer list. The names on your buyer list come from your Contacts page. 
We haven’t looked at this yet but there is no need to go to it to add the buyer as a Contact.  
Just click the Add Contact button to create one now.  
The Add New Contact form opens. Fill in the details and save (see the Contacts section below) . After you save the 
contact you will be returned to the Add Sale form. You may now select the contact name and add notes on this 
purchase. 
Save the Sale record. The sale table should update with the changes. 
 

Edit / Delete 
 
To Edit a sale record click on the entry in the sale table to open the Add Sale form again.  
It will display Update and Delete buttons. Make changes then click Update when done. You may also delete the 
record using the Delete button. 
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Cage 

 
The cage function can be accessed from the Cage button on the toolbar. It’s main use is to provide a quick list of 
animals with their cage (pen, paddock, tank etc) and tag numbers. If you run a large breeder it may help you 
quickly locate and organise animals by their location and Identification. Filters determine what is listed. 
 

 
 
 
 

 
Calendar 

 
 
The Calendar links the records from the 
Individual, Mating, Treatments and Reminders 
pages together and displays them in Date order. 
 
Only events dated from the previous fortnight to 1 
year ahead are displayed. You can skip to today 
by clicking Go to today at the top of the page. 
 
Calendar entries include: 
 
1. Breeding events such as when to prepare 
a nestbox and the expected birthdate 
2. Treatments from the Health page which 
have not been done  
3. Reminders not completed 
4. Animal’s birthdays 
5. Reminders to backup your databases 
 
 

 

If anything appears or does not appear in the Calendar when you think then refer to the list above to determine 
why. For example: 
• Remove a completed reminder by checking Done on the reminders page. 
• Prevent a dead animal from displaying a birthday by checking Deceased on the Edit record form. 
• Stop Breeding reminders for an unsuccessful mating by checking Not Pregnant on the  
mating form. 
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The calendar displays in webpage format and can be printed. 
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Contacts 
 

 
 
The Contacts page contains a simple list of persons 
or organisations which you have dealt with. You can 
use it for club members, buyers, suppliers or anyone 
you please. 
 

 
 

Add 

When you click the Add button  on the Contacts 
page. 
A form opens where you can add a new contact record  
and notes. The minimum information is the person or 
organisation name. 
 

Edit / Delete 
 
To Edit a Contact record click on the entry in the sale 
table to open the Add Contact form again in edit mode. 
It will display Update and Delete buttons.  
 
Make changes then click Update when done. You may 
also delete the record using the Delete button. 
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Inbreeding Calculator 

 
The inbreeding calculator can work out the COI (Coefficient of Inbreeding) using Wrights formula for an existing 
animal or a prospective offspring resulting from a mating of two animals. The accuracy of the COI depends on how 
much information your database contains and should be used as a guide only. 
 
Wrights formula 
 
The COI is indicates the possibility that two alleles of a gene are completely alike with another animal in the 
pedigree. 
 
 

 

Fx - The inbreeding coefficient of the animal in question 
Fa - The inbreeding coefficient of the common ancestor 
n1 - The number of generations from the sire to the common ancestor 
n2 - The number of generations from the dam to the common ancestor 

 

  To open the Inbreeding Calculator click the Inbreeding button on the toolbar.  
Because Kintraks takes a little time to calculate the result it is best to calculate the cOI of all animals in one go and 
store the result with each record. Then the program can COI the result instantly whenever needed. If you add more 
animals later on you can simply run this process again to update all COI based on the new information. 
 
To update COI for all animals click the Update 
All button and wait for the calculations to 
complete. This could take some time if you 
have a lot of records. 
The other buttons will show previously saved 
COI for all your animals or just your current 
stock. 
 
  

 
If a COI isn’t calculated for a record it will show a reminder message when the details are displayed. 
 

 
 
After you click Update All the COI will be listed from highest to lowest. You can click on the other column headers 
to sort alphabetically. 
  

 
 
After Updating, the COI is stored with each record and will appear with the details on the Individual page. 
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You can also do a calculation for a test mating to get 
the COI of the offspring.  
Select two animals from the list and choose how many 
generations you would like the program to search 
(more than 6 doesn’t make much difference and takes 
a lot longer).  
Click the Calculate button to list all common ancestors 
and their contribution to the total COI. 
 

 
 
 

  
Use the Inbreeding COMPARE function to test mate an animal with selected partners to see the COI percentage 
for offspring. 
1. Select a subject animal from your SEARCH list then click INBREEDING from the toolbar. 
2. Choose COMPARE and select potential partners from the list. Windows/Linux hold down Ctrl + click / Mac use 
Cmd + click to select individual names. 
3. Click the COMPARE button to view a list in order of most likely to produce inbred offspring to least likely. 
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Common Questions 
 
WHAT IS COI? 
The probability of inheriting two copies of the same allele (gene) from an ancestor that occurs on both sides of the 
pedigree. 
 
HOW IS COI CALCULATED? 
Kintraks uses the most common formula for calculation devised by Sewell Wright in 1922. 
If an individual is inbred, their sire and dam are connected in the pedigree by lines of descent from a common 
ancestor or ancestors. The coefficient of inbreeding is obtained by a summation of coefficients for every line by 
which the parents are connected, each line tracing back from the sire to a common ancestor and thence forward 
to the dam, and passing through no individual more than once.  
 
IS COI AN ACCURATE MEASURE OF INBREEDING? 
Your COI calculation is only as accurate as the number of available generations you have in the pedigree, six is 
fair, ten is better. Remember also that the COI is only a measure of probability. It does not guarantee that the 
allele was passed on to the next generation every time. It can however predict the potential danger from a 
particular mating in terms of decreased fitness etc. with reasonable accuracy. It is still one of the best tools a 
breeder can use. 
 
THE COI IS ZERO EVEN THOUGH THE SIRE IS HIGHLY INBRED? 
Only common ancestor affect COI. If they don’t share common ancestors in their pedigrees the COI is zero 
(based on available data). Breeding two completely unrelated animals is outbreeding not inbreeding. 
 
WHY DO I NEED TO UPDATE ALL THE COI IN KINTRAKS? 
Many programs do a quick COI calculation based solely on the number of generations in the path between the 
common ancestors. But there is more to the formula than that. Wright’s formula also includes the accumulation of 
individual COI of every common ancestor (see Fa in the formula). This part is usually left out in many programs 
because it is complex and time consuming to calculate but leaving it out can reduce the final percentage 
significantly. 
The Kintraks solution is to pre-calculate the COI for all records first and store them so COI of common ancestors 
can be included instantly. To improve accuracy you should click UPDATE ALL on the Inbreeding Calculator with a 
10 generation search whenever you add more ancestor records. This will make common ancestor data readily 
available for all other calculations.  
Note: If you do not have a date of birth for all your animals this may produce variations. The calculations need to 
be done in birth order so ancestors COI can be used in offspring results. If you have no dates of birth you may 
find the results improve with a second run of the calculator. 
 
WHAT IS AN ACCEPTABLE LEVEL OF INBREEDING? 
This varies enormously depending on the species and breed. Research your breed to determine this. 
 
ONE OF MY ANIMALS HAS AN EXTREMELY HIGH COI WHICH I’M SURE IS WRONG? 
Inaccuracies in the pedigree eg. An animal being an ancestor of itself, can create a circular calculation error 
leading to an inaccurate result. I am currently improving the error checker to spot pedigree anomalies that cause 
bad calculations. 
 
CAN I CALCULATE COI FOR MORE THAN 10 GENERATIONS? 
The main limiting factors are computing power and calculation time. If your computer is unstable or low on 
resources it can cause the program to freeze or system crashes. However the option will be available soon for 
those that want to use it. 
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Language 
 

 
By default, the Kintraks program is in English. By copying a language file to your computer, you can convert the 
program into another language. You can also use the English language file to substitute words and phrases to your 
personal preference.  
You can download language files from the Website help page. If the program is installed on your computer, open 
the language archive Language.zip and find your language file language.csv in the appropriate country folder. 
Drag the file language.csv to the main program window to add it to the program. For portable mode save it to the 
same location as your databases. 
 
Note: Language files are compiled and donated by Kintraks users. If you would like to create a language file for the 
benefit of all users, please contact us. 

Edit Translation 
You can add translations to your language file from within the program. Click the Language button from the Tools 
icon on the toolbar to open the Language form. 
 
The left column contains the English word. In the right column edit or add a translation or substitute word. You can 
sort columns by clicking on the Header. To add a new word, click the Add button and follow the prompts. 
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Pedigree Designer 
 

 
 
Pedigree certificates may be printed on paper or stored as a file for printing or Email (see the next section 
Pedigree for Web and Email). 
 
When you are ready to view a pedigree click the Preview button. Don’t be alarmed at the initial result. Almost every 
part of the page can be customised to your personal preferences and then saved as a template so you only need to 
design it once. 
 
Screens Windows 7 
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Preset Templates 
The program comes with some preset designs to give you a starting point.  
This also to enable you to get all the printable objects back on the page if you get too 
radical with your design. 
 
You should start by choosing a preset design. This will be determined by how many 
generations you want to display. For example: 3g displays 3 generations back so you 
get parents, grandparents and great grandparent.  
 
The number of generations may also be determined by what’s normal for your animal 
type. Do a little research on what is normal with clubs and breeder groups. 
 
Then decide on the best orientation. Long animal names fit better with  
Landscape whereas lots of details on different lines suit Portrait. 
 

 

Customise 
 
Screens Windows 7 
 

 

Some people actually enjoy this part. By using the buttons on the 
Toolbar you can customise many aspects of your pedigree template.  
Clicking a Toolbar button displays the options in the section on the left. 
Click Templates to display your preset list again.  
 
Not all options can be customised for a HTML pedigree as it is 
determined by what can be easily altered in a web page format.  
 
The information below refers to making pdf and paper pedigree 
certificates. 
 
 

 
Page Layout 
Landscape and Portrait will set your printer orientation before printing. 
 
Half page will print a small pedigree certificate in landscape orientation in the top 
half of the page. 
 
The Margin setting determines what percentage of the page width is left blank. 
Choose a number from the list. 
 
If you set this to 0 (zero) your printer will print as close to the edge of the paper as 
possible. Minimum allowable margins for your printer may override this. 
 
Not every printer is the same. Do a test printout to see if the certificate fits on the 
paper. 
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Font Type / Colour 
 
There are three sections of the pedigree where you can customise the font type, style and colour of the fonts. 
You may also wrap text by moving the Wrap slider at the bottom of the options. 
 

 
 
Wrap 

 
 
 

 
 
 

 
 
 
            Title 

                
 
            Main Animal Details          

                 
             
              Generation Details          

                  
 

 
 
 
 
 
Changes the font properties 
for the title (in red). Normally 
this is the Stud or 
organisation name. 
 
 
 
 
 
 
 
 
Changes the main animal’s 
details and the line under the 
title: “Pedigree of …..”  
 
 
 
 
 
 
 
 
 
Changes all animal details 
apart from the main animal. 
Changes the Personal details 
section at the top of the page 
and the certification at the 
bottom. 

 

Picture 
Before you can display a picture in a pedigree you need to add it to the 
pedigree picture box on the animal’s individual page. (see Pictures). Once 
that is done choose Picture from the picture options. 
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Adjust picture size and position by moving the sliders. You can move your 
picture to the other side of the page or enlarge it to use as a backdrop. 
Add a shadow if you like by checking the Picture Shadow box.  

 
 

Background 
 
A nice uncluttered background will really give your pedigrees a professional touch.  
 

 

 
If you don’t want a background click  
the Clear button. Because your 
certificate won’t have an edge it is 
usually best to check the Add 
border button to add a thin black 
border. 
 
The Bracket Colour and Bracket 
Width (line thickness) controls are 
used to format the pedigree 
connectors.  

                   

To choose a background from your 
computer click the Add button. The file 
will be copied to your Kintraks folder. 
Because everyone has their own 
preferences Kintraks only comes with 
one background, a tree with a fancy 
border. 
This is the default background which is 
built into the program.  
 

 
 

  

Tip: To hide all connectors slide the Bracket Width all the way to the left. 
 
Download a background 
I have made numerous backgrounds available online to suit all types of animals. These were all at the request of 
breeders so if you have a preference or a particular picture you think might be suitable let me know. 
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To go to the backgrounds page on the web choose 
Download Backgrounds from the Help menu. 
 
 
Follow the directions on the webpage to download  
to your computer. 
In the background section (above) click the Add button  
to browse for the file and add it to your pedigree 
layout.  

 
You can then adjust the transparency of the background using the slider. Move to the right to make the background 
more transparent. 
 
Add / Remove Fields 
 
This option allows you to choose the information that appears in your pedigree. The program uses variables which 
will be substituted for the field contents for the particular animal. Each box represents the layout for each 
generation. 
If you click the Show Help button you can get a list of the variables available for your regular fields and custom 
fields. 
 
 
 

 

 

 

Details 
This option adjusts the position of your personal details (from your Settings) and certification. Use the Horizontal 
and Vertical sliders to adjust the position of each block of text. 



[Type here] 
 

 
 

 
 
You can also enter any text of your own choice in the Custom Details box and 
it will appear on the pedigree. Adjust the position with the sliders.  
 
Save 
When you close the Preview form you will be asked to save the settings. Click 
Yes to save the settings as your own custom pedigree template. 
 
Save As 
You can duplicate a template under a new name by using the Save As button. 
Saved template names will appear on the Template list below the preset 
items. 
 
Delete Templates 
To delete a template right click on the template name in the Template list and 
choose Delete. 
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Reminders 

 
Screens Windows 7 
 
Kintraks has a Reminders page which allows you to enter any reminder or appointment. This gives you a list of 
reminders which can be filtered by Not Completed. 
Reminders which are not completed will also appear on the program Calendar. (see Calendar) 
 

 
 
Add 
Choose the Reminders button from the toolbar to open the Reminders form. 

To add a reminder record click the Add button  on the Reminders page to show the Add New Reminder form. 
Enter the Date and a short reminder note. Click Save to add it to the database. 
 
 

 
 
Edit / Delete 
 
When you no longer need the reminder click on the entry in the Reminders table to open the Reminders form in 
edit mode. 
It will display the information you entered. Check Done and click Save if you want to keep a record that you have 
completed the appointment or task. Click Delete if you want to remve the reminder from the database. 
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 Reports 

 

 
 

Most search results in the program can be printed as a report using the small Print button above the table. 
Your Operating System Print Dialog will appear.  
 

 

 

 
You can print a paper copy or pdf (Adobe Acrobat) format. Pdf printing is built into Mac operating systems but 
requires a pdf maker to be installed on Windows and Linux systems. 
There are plenty of free pdf makers available for Windows eg. doPDF or pdf995. Once installed you simply print to 
them from your print dialog as though they are an installed printer. 
Pdf files are an excellent way to store and email reports and pedigrees. You will need a pdf reader such as Acrobat 
reader (free) to view them but since the pdf format is so common these days most people have it installed already. 
 
Customising your report 
 
You may resize columns before printing to display the information 
better or to hide columns altogether. Move your mouse cursor 
over the lines between the column names until your cursor 
changes  
then drag to resize. 
 
Column widths on the printout will reflect the percentage of the  
table width in the program eg. If you resize a column to ¼ of the 
table width it will take up ¼ of the paper width when printed. 
To hide a column resize it to zero width before printing. 

Screens – Linux Ubuntu 10.4 (32 bit) 
 
 

 

 
The printed report has a basic layout: 
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Pedigrees - pdf and web 

 
 
Kintraks can create a pedigree in two formats – pdf (Adobe Acrobat format) or HTML (Webpage format). 
 
PDF Pedigrees 
Anything you can print to your normal paper printer can be stored in pdf format. 
 
Pros 
• Retains all customisation, graphics, colours, fonts, object positions etc (see previous section) 
• Popular format for Email 
• Quality paper prints can be made anytime from the pdf file 
.Cons 
• Requires pdf reader eg. Acrobat Reader to be installed (free) You have a pdf reader if you are reading this. 
• Requires pdf maker eg doPDF for Windows (free) 
• Cannot be altered after making, at least by using readily available software. 
 

How to make Acrobat pedigrees and printouts 
  

Anything you can print from your computer can also be "printed" to an Adobe Acrobat file (pdf) and will appear 
almost identical to the paper output. 
To do this click the Print To PDF button from the toolbar. 
 
  
Your program "prints" as normal but instead of the output being on paper it will be saved as an Acrobat (pdf) file.  
You will be prompted to give your file a name and to choose a location to save it to. You can store pedigrees on 
your computer for printing or emailing later on. Don't forget to tell the recipient that they need the free Acrobat 
Reader to view and print them (most people already have it). 

HTML Pedigrees 
These are web format pedigrees consisting of a box (table) style with no graphics. 
 
Pros 
• Very compact for Email and storage 
• Can be opened on any computer using the web browser 
• Page can be uploaded to the web or the pedigree pasted into your page design 
• Can be copied and pasted into other formats eg. Word document 
• Editable in any webpage editor and many text editors 
• Resizes automatically to fit screen 
 Cons 
• You’re stuck with a basic and plain layout if you don’t know much about HTML editing. 
• Pictures and backgrounds need to be with the file to appear in the pedigree unless you save it as 
Webpage Complete format. 
 
To make an individual HTML pedigree select a name from the Search list and open the Tree tab. 
Select the HTML pedigree button above the Tree tab. Choose from the options and click the Create Button. 
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The pedigree will open in your web browser when finished. 
By default HTML files are stored in the folder -
Documents\Kintraks\HTML 
 
You can access this folder easily by selecting from the top 
menu – View > Folders > HTML Pedigrees. 
 
 

 
You can also create a full pedigree collection for all your animals by selecting the HTML Pedigree Collection 
button. You can then choose from the same options shown above. 
This will produce a folder of individual webpages and an index page where users can search for an animal. All 
pedigree names are links so users can click to open other pedigrees. 
If you have a lot of animals, it may take some time to produce all the files required. Check the progress bar at the 
bottom to see how the process is going. 
When done the index file will open in your web browser. 
Uploading your pedigree collection is a separate process to the functions in Animal Breeder. You can find 
information and free programs to manage your web files on the Internet. 
After uploading your whole pedigree folder to your public directory link to the folder or the contained index.html file 
from your homepage. 
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Importing  
 

 
 

Importing Records 
 
There may be times when you need to transfer information from other sources whether it is another database, a 
spreadsheet or document. Kintraks can import data from other Kintraks databases or HTML pedigrees. 
 
Importing a Kintraks database 
 
You can easily import a whole database or selected records from another Kintraks database file. From the top 
menu click Database > Import to open the Import window. Follow the numbers - 
 
Screens Windows XP 
 
(1) Open 
Click the Open button to select a Kintraks database file (.cax  / 
.rsd) 
It can be anywhere on your computer or removable media. If it is 
attached to an email you must open the email and save the file to 
your computer first.  
When you open the file a list of names should appear in the form  
list box (2) 
 
(4) Click names on list to select records 
If the database contains records the names will be listed in the 
box. Hold down your Alt button (Windows/Linux)  
or Apple key (Mac) while clicking on the names you want to 
import. 
To select all or clear use the buttons at the bottom. 
 
(5) Status 
Don't change Status 
The status will stay the same. Suitable if you are merging two 
databases you already own or splitting a database into two 
separate files.  
Not suitable if the database belongs to someone else as some 
records will be marks "I am the owner"(that’s not you!)  
 
Make all "I am the Breeder" / Make all "I am the Owner" 
May be suitable depending on what you are doing. Remember 
you don't need to import everything in one go. You may want to 
import records you bred and mark them as such. Then in a 
separate operation import records you didn't breed. 
Import Sold Stock Details 
Gives you the option of importing the original status but not the 
sold stock if you weren't the seller. 
Don't Import Duplicates 
If records for the animal already exist the record won't be copied 
across while this is checked. If you want to see if the record has 
more information than yours you can uncheck this option and 
import all records. . 
 

 
 

 
 

 



[Type here] 
 

(5) Import 
Click this button to start the process. You will see a confirmation  
when completed. 

 

 
 

 
 

Importing a Pedigree Template 

 
When you choose this option from the above menu only the custom pedigree templates will be imported from a 
Kintraks database file (.cax). 
This is handy if you want to keep a uniform pedigree template across several databases.  
 

Importing a CSV File 
 
To import a CSV file open the Import window by selecting Database > Import from the top menu. 
This section outlines the basics of preparing your CSV file for import. 
 

Tip: This section may seem a little heavy but it’s not as heavy as typing in hundreds of records by hand. It is far easier to 
spend some time preparing and importing your data automatically. If you get stuck please don’t resort to manual entry just 
email me for help. 
 
CSV format 
 
What is a CSV file? 
Csv (Comma Separate Values) format is plain text where each row is a record and each item is separated by a 
comma. The top row is the column titles. Because of it’s simplicity it is often used as a means of transferring data 
between different programs.  
Csv files can be opened and saved using a plain text editor or a spreadsheet program. When you open a csv file 
with a spreadsheet program such as Microsoft Excel it sorts the data into columns. This makes it easier to prepare 
you file for import. Here’s the same file opened in different programs: 
 

 

 
 
  



[Type here] 
 

1) Obtain a CSV file 
 

Other Breeder 
program 

You should be able to export your data as csv. Check the menus for an Export option 
and look for csv or text format. Export your data. 

Spreadsheets If you keep your animal records in a spreadsheet make sure the top row contains column 
headings and save or export the file in csv format. 

Microsoft 
Access 

If importing from a Microsoft Access database, open the file in Access then choose the 
Export option - Text File. A wizard will guide you.  
Do not check the option to Export Data with formatting and Layout. Choose comma  
as the delimiter and check the box to Include field names on first row.  
When you choose a file name and location save the file with the extension .csv rather  
than .txt. 

Emailed files If the file arrived in an email then save the file to your computer before doing anything. If 
it is on a disk, don't work with the original file in case you mess it up. Save a copy to your 
computer and use it for importing. 

Paper copies Not much point entering them into a spreadsheet then importing them.  
It is easier to add the data as individual records using the Add button. It has some time 
savers such as creating records with similar details. 

 
You must be careful when saving a csv file that you save it only in its original format and not the programs native 
format eg. doc (Word), xls (Excel) etc.  
Kintraks cannot import these formats. You must use the "Save As" option to save as a csv file.  
If you don't have a spreadsheet program on your computer then download a free csv editor such as  CSVed or the 
next few steps can be quite tough. 

2) Create a blank database 
We don't want to take any risk with our existing data so let's get all the data into a separate Kintraks database 
format first. Click Database > New from the menu. Give it a name eg. "Imports from Jerry". You will be prompted 
for user settings. You don't need to fill in everything but make sure you enter any custom fields the same as in your 
existing database and in the same order.  
 
Write them down you will need your list later eg.  
Custom field 1 - legs 
Custom field 2 - tattoo 
3) Try to import  
I am always working on making the import process fully automatic. The program can now recognise many common 
(English) field titles and automatically copy the contents across. 
Open your File Converter and choose FROM > CSV file TO > Kintraks Multiplatform version. 
4)  
5) Give your columns a title  
OK it didn't go to plan or you wouldn't be still reading this. We are going to have to make a few alterations to our 
csv file before trying again. Create another blank database and read on - 
 
Open your csv file in your spreadsheet program. If your csv doesn't use row 1 for column headers then insert a 
row. If it has headers then rename them to match Kintraks fields below (the column order doesn't matter) - 

name    colour    breed    sex    dob    father    mother    tag    prefix    suffix    health    cage     
callname    notes 

Any other fields can be named as custom fields to match your custom field numbers you wrote down in step 2 
above. 

customfield1    customfield2    customfield3    customfield4    customfield5    … customfield15 

6) Remove commas and blank rows from data 
When you open a csv file in your spreadsheet program or CSVed you can't see the commas that separate the 
columns. Check your file for other commas which may exist in fields containing sentences eg notes. These 
commas will cause the import to fail. If you're not sure select the whole page and use your spreadsheet programs 
find/replace  function to substitute another character or no character at all eg.  
Find what:      ,  
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Replace with:       [leave blank] 
Also check that the file doesn't contain any blank rows. A simple way to do this is open the file in Notepad or 
Wordpad and turn off word wrap. Each row should begin with the same field information. Check for line-breaks 
where a record is not contained completely in one row. Edit and save to correct these problems. 
7) Check all parents have their own record 
For family trees to be created correctly there needs to be a separate record for every parent. Most programs do this 
automatically but if you are importing from a different source such as a home spreadsheet there could be typos or 
inaccuracies. If you are aware that this is the case you can fix it.  
Select all the cells in the Mother column except the header and copy them.  
Paste then at the bottom of the name column. Go to the first pasted record and under Sex and enter "female".  
Drag the cell by the corner to fill in "female" in all the blanks below it. Kintraks doesn't require any other data to 
create a record.  
Do the same with the Father column but enter "male" in the sex column and drag it down. Now we've probably 
created hundreds of duplicate records but the Kintraks program has a "Fix Data" option to remove all the extras 
later on. Save regularly, perhaps save as a new name before big changes. 
 
8) Save as CSV and try importing again 
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Shortcut keys 

Function 
 

Windows / Linux Mac 

Help 
Search 

Select All 
Backup All 

Copy 
Calendar 

Error check 
News 

Contacts 
Import 

Inbreeding 
Restore 
Repair 

Language 
Reminders 

New Database 
Open File 

Pedigree Designer 
Quit 

Add Record 
Settings 

Reset Window 
Reports 
Paste 

Reset Columns 
Cut 

Cages and Tags 
Undo 

 
 
 

Function F1 
Function F3 
Ctrl + A 
Ctrl + B 
Ctrl + C 
Ctrl + D 
Ctrl + E 
Ctrl + F 
Ctrl + G 
Ctrl + H 
Ctrl + I 
Ctrl + J 
Ctrl + K 
Ctrl + L 
Ctrl + M 
Ctrl + N 
Ctrl + O 
Ctrl + P 
Ctrl + Q 
Ctrl + R 
Ctrl + S 
Ctrl + T 
Ctrl + U 
Ctrl + V 
Ctrl + W 
Ctrl + X 
Ctrl + Y 
Ctrl + Z 
 
 

Function F1 
Function F3 
⌘ + A 
⌘ + B 
⌘ + C 
⌘ + D 
⌘ + E 
⌘ + F 
⌘ + G 
⌘ + H 
⌘ + I 
⌘ + J 
⌘ + K 
⌘ + L 
⌘ + M 
⌘ + N 
⌘ + O 
⌘ + P 
⌘ + Q 
⌘ + R  
⌘ + S 
⌘ + T 
⌘ + U 
⌘ + V 
⌘ + W 
⌘ + X  
⌘ + Y 
⌘ + Z 
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Backing up your data  

 
If you are running Kintraks from your computer and you regularly backup your Documents folder then your 
Kintraks databases will be backed up too. If not, you need to make regular backup copies to preserve your records 
in case of computer malfunction, theft or destruction. 
 
Making a backup on the same computer is helpful if you need to return to a previous save in the case of 
accidentally deleting records but is of little protection against anything else. 
The backup file should not be saved to the same computer or drive. 
 
Where to backup files 
 
Good locations to create a backup include: 
           *   Removable media – CD/DVD, External Hard Drive, Flash drive 

*  Another computer eg. your laptop or other home computer 
*   Online location eg. Your online storage or mail file (Email it to yourself) 

 
The best time to make a backup is before and after any major change to your database:  
Before: Updating to a new version, Merging deleting or splitting a database, Importing records 
After: Creating a new database, Entering a batch of new data. 
 

Making a backup to your online archive 
 
As a registered user you have free online backup on 
the Kintraks server. 
 
From the top menu choose Database > Backup > All 
Databases To Online Archive. 
 
You also may backup individual databases by right-
clicking on the file name in the programs opening page. 
 
Wait until all uploads are complete before moving onto 
another function or closing the program. Failure to do 
this may result in a corrupt upload. 
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Making a Backup to Disk 
 
Simple Windows Method 
 
1. Insert a CD/DVD  into your computer drive 
2. Open your Documents folder 
3. Find the Kintraks folder and right-click 
4. choose Send To > CD/DVD Drive (or similar) 
5. Follow the prompts to burn it onto CD. 
 
Alternatively use a CD burning program eg. Nero to do 
the same thing. 
 
You only need to backup the Kintraks folder.  
 
It contains: 
          Databases 
          Registration key 
          Pictures 
                       HTML pedigrees created  
 
 
Simple Mac Method 
  

1. Insert a blank CD/DVD disk in your drive.  
2. A CD icon appears on your desktop. Double-click to open a Finder Window 
3. Open another Finder window by clicking on the File menu, click New Finder Window. 
4. From the Finder window, click on Documents then select the Kintraks folder and drag-and-drop it on to 
the CD Finder window.  
5. Select Burn "Untitled CD" (Leopard 10.5 >) or Burn Disc (Tiger 10.4) from the File menu. 
6. Name the disk, then click Burn.  
 

Restoring a backup 
 
 

Insert your CD and view the contents in Windows Explorer or Mac Finder. Drag the Kintraks folder from the CD to 
your documents folder. If you already have a Kintraks folder be careful. Don’t overwrite a new copy of a database 
with an earlier one (unless you want to go back).Online Backup 
 
Another good backup option is to backup to the Internet. It is becoming increasingly popular to store personal files 
using a cloud storage service. Most of the services offer a free storage limit of up to 5gb before charging for 
additional space. This is plenty of room to backup your Kintraks databases many hundreds of time. 
 
The program includes two options for you to try – Dropbox and Google Drive. Both offer free storage and the 
program can be setup automatically to backup to the Internet everytime you close. Just go to their website and 
install onto your computer. 
 
Open Kintraks and choose the option from the Backup toolbar manu. 
 
 
Agree to the prompt and the backup is set to go.  
Kintraks will create a new subfolder for today’s date on your computer and sync it with the folder on your cloud 
drive. Subsequent backups on the same date will be incremented eg. [date](0)    [date](1) 
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Trouble shooting  

 

Lost Databases 
 
You turn on your computer and start the program and it dawns on you that something is suddenly different. The list 
of databases is empty, and chances are your program isn’t unlocked or showing you as being the registered owner. 
There are several reasons why this could happen but usually it doesn’t mean you have lost everything. It most 
probably is because the databases aren’t in the location the program was using last time you ran it. 
You may have accidentally changed the path while browsing for a database somewhere else or by clicking the 
various location buttons at the top of the list. 
Another common occurrence is that Windows 10 upgrade has moved or renamed the Documents folder or you 
may have agreed to let OneDrive be the new location for your Documents and Windows has kindly moved 
everything out of your old folder. 
Either way you have got to find your lost files. 
Firstly check the database path. This is the blue text at the top of the OPEN page. 
Is this the folder where you normally keep your databases? You’re not sure?  
Perhaps you never changed the path at any stage and just let the program create them in the default location. This 
is in your Documents folder in a subfolder called Kintraks. If your computer has multiple accounts, make sure you 
are using the same login as before. You won’t be able to see the contents of your Documents folder if you are not 
logged into the same account. 
The path should read:  
C:\Users\[your Username]\Documents\Kintraks\ 
 

 

To check the default location for databases, click the small House button above the database list. This will 
display the default folder. Try clicking each of the Location buttons - 
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Can you see your databases now? No?  
Then it’s time to search for them. 

Windows  

1. Open File Explorer - Find it in your Taskbar  or hold down your Windows key and press E. 
2. In the left-hand column display the contents of your computer by clicking This PC 
3.  Enter .cax in the Search box at the top right of File Explorer Window.   
 
 

 
 

Mac 

1. Open Finder  

2. Enter .cax in the Search  box  

3. Click  next to the word Search at the top of the list to expand the search to your whole 
computer. 
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When the search is finished you probably have many databases in view. Some may be earlier versions or backups 
so it’s important to find the most recent copy. 
If you didn’t find your database there may be still other options you can try later. Make sure your list is displaying 
the file details by clicking the option in the bottom right hand corner in Windows  or on your Mac, in the toolbar at 
the top of the list. 

             
Windows             Mac 
 
Now we should be able to click the header of the column to sort by Modified date to find the last database we 
worked on. 
Note: If there is no column for Modified date right click any Header and choose the option from the list. 

          
You can also use other criteria such as Size to determine if one copy of a database holds more information than 
another. 
Now let’s look at copying it to your default folder so you can use it. 
You’ll need to have both the program and the File Explorer (Windows) or Finder (Mac) open at the same time as 
Animal Breeder. Make sure both programs are visible and not maximized to full screen. You may need to resize the 
Search results by dragging the borders in so you can see it on the screen. 
 
Now drag and drop the file you want to the blank space on the OPEN page. 
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The file name should immediately be added to the list. Continue with other databases you need added. If you add a 
database with the same name as an existing one a number eg. (1) will be added to the end of the filename.  
This allows you to add several copies for checking contents if you  aren’t sure which one you want to keep. The 
program should also copy your registration key reg.cav and associated folders across. 
Open your file to check contents. Click in the Animal Breeder Search box to show all records and to see the total at 
the bottom. Once you open a file the program will store the new database location so it is visible next time you 
open the program. 
 

Error Messages 
Error #5 – Permission Denied 
You are trying to install or update the program while 
it is open or one of it’s components is still  
running.  
Close Kintraks if it is visible on your screen or 
taskbar and try again. 
If that doesn’t work hold down Ctrl+Alt+Del >> 
Task List >> Applications.  
 
Click on Kintraks if it’s on the list then End Task. 
 
Run your installer again. If nothing works then  
reboot your computer, don’t open Kintraks just run  
the installer / updater again. 

 

 

Asking for help  
 
If this help file doesn’t give you the answer to a problem you are welcome to email me with your question. 
 
From the menu click Help > Request Help (Ctrl+E) 
 
Enter your problem in the Email form. Don’t forget your reply email address and 
a Subject.  
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Most problems are easily fixed. If there is a bug in the program an update is 
normally released as soon as possible to remedy it. 
 
 
  

 

 

 
 

 
If the problem cannot be duplicated you may be asked to email your database file and name a particular record 
where the problem occurs. 
 
You will find your database files on your computer by opening your Documents folder then the folder called 
Kintraks. The file(s) will have the name you gave it eg. “Dogs.cax”. 
 
If you are running the program from a removable drive it will be in the same location as the program. 
 
Attach it to an email and send it to - 
support@kintraks.com 
 

Suggestions for improvements  

 
Your feedback is always welcome. Just email me anytime at support@kintraks.com 
Many of the features in Kintraks were the result of user feedback. It is especially helpful if you can report bugs or 
annoyances so I can fix them for everyone as soon as possible. 
 
I try to accommodate as many suggestions as possible with the release of each update. 
Keep in mind that Kintraks is a generic program which can already be customised to suit many animal types. If your 
suggestion is too specific for a particular species it may not suit all users eg. Genetic calculations and predictions 
which only refer to one animal type.  

I also avoid copying features from other programs so as to keep the originality and appeal of Kintraks.
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